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EndNote Bibliographic Software 
The Lamar Soutter Library 

 
 

 

About EndNote Software 
 

With EndNote you can manage information through searching the literature, organizing pertinent 

references, and by creating bibliographies.  EndNote now allows you to manage graphics and captions. 

 

An EndNote “library” is a collection of reference records. The reference information can be entered 

manually or imported from databases such as MEDLINE. Keywords, notes, abstracts, URL‟s and other 

information can be included in the “library” records. 

  

Create a Library in EndNote 
 

1. Open EndNote. 

 

Start  Programs  EndNote EndNote Program. 

The EndNote  window will appear. 

 

2. Choose Create a new EndNote library  and Click OK. 

 

 

 
 

3. The New reference library window will appear.  

 

4. You can save the new library on your hard drive, your H-drive, department shared 

network drive, or a flash drive. 

 

In the box next to File name:, type the file name. Click the Save button. 

The file name will have a .enl extension. 

 

5. The new (empty) library will appear on your screen.  
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Setting up the Journals Term List in the New Library. 
 

For each new library you create, you should set up the journals term list.  Depending on the output style 

you choose later, your bibliography may show journals titles written in full, or abbreviated with periods, 

or abbreviated without periods.   

The terms list that you import below will allow you to edit the style you choose to show full or 

abbreviated titles. 

 

1. Tools  Open Terms List  Journals Term List  

 The Term Lists window will open. 

 

2. Click on the Lists tab, click on Journals, then click on Import List 

 

  
 

3. Open  C:\Program Files\EndNote_\Term Lists\Medical 
A message will appear : 

      “8908 terms inserted into the „Journals‟ term list.” 

 Click OK. 

Close the Term Lists window. 

 

 

Changing Library Display Fields   

In the library window, EndNote defaults to showing first a paper clip if a graphic or file is attached to a 

reference, then the Author, Year, Title, and URL fields. You may display other fields, change the order of 

the fields displayed, or change the names used for the column headings in the library window.  

To customize the library window display: 

1. Edit  Preferences 
2. Click Display Fields  in the list to the left. 

3. Choose the desired field from the Field list. You may select up to five fields to be displayed in the  

       library window. Select Unused instead of a field name if you want to show fewer than five fields. 

4. Click OK to save the changes and close the Preferences dialog.  

These settings will apply to all of your libraries. 
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Entering References in an EndNote Library 
 

Endnote libraries created in version8 and later hold an “unlimited” number of references.  (Earlier 

versions held approximately 32,000 references with a library size limit of 32 MB.) 

There are various ways to add references to the library: 
 

1. Manually entering references 

2. Downloading references from a database such as MEDLINE 

 

Enter References Manually 
  

1. Open the library you wish to use: 

 

File  Open  Select the library (.enl file) you wish to use. 

 

2. References  New Reference. 

 

3. The New Reference window will appear. 

 

Enter information in each field for a journal article reference. 

Use the Tab key or mouse to go from field to field. 

 

(Don‟t worry about punctuation, bolding, or using italics. 

EndNote will format the information appropriately.) 

 

4. At the top of the window under Reference Type: Journal Article is the default. 

Click the ▼ to select a different reference type (book, etc)  EndNote has added 

several new reference types….Figure, Chart, and Equation. 

 

5. After entering information, close the New Reference window. 

The reference information will be saved. 

(Tips for entering information in selected fields appear on the next page.) 

 

6. Repeat steps 2-5 to enter additional references. 
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Manually Entering Information in Selected Fields 
 

The following tips will assist you in manually entering information. 

Entering Author Information 

1. Enter names “Last, First initial. Middle initial”.  

When entering corporate authors, put a comma after the name.  

If the corporate author name contains a comma within the name, add two 

commas at that point.    

 e.g.,         Administration on Aging,, Department of Health and Human Services  

                 U.S. Department of Agriculture,  

                 Apple Computer Inc.,  

2. Put a period between initials, e.g., Lobo, M.V. 

3. Enter author names one per line 

4. New Names will appear in red text. 

 

 

Entering Journal Names 

 

In the New Reference window, select the Journal field. 

Start to enter a journal name and EndNote will suggest a match in black text. 

If you enter a journal name not on the list, it will appear in red text. 

 

Or Click on Tools  Open Term Lists  Journals Term List.  Then double-click 

on the journal in the terms list and it will appear in the Journal field of the reference. 

 

 

Entering Page Numbers 

 

Enter page numbers completely 1321-1329 or in an abbreviated manner 1321-9. 

 

 

Entering Dates (Month, or Month and Day) 

 

Enter month (if given) as you would like it to appear in your bibliography, e.g., use Sep 

for September.  Month and day may be entered (Sep 27). EndNote does not reformat  

month dates. 

 

Editing References 

 

To edit a reference, double-click on the record in the library window. 

A window with the reference noted on the top bar will appear. 

Make the necessary changes. 
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A Word About Graphics and EndNote 
 

EndNote features several reference types (Chart or Table, Equation and Figure)  which can be used 

specifically to catalog images and files in an EndNote library, and may contain minimal reference 

information. 

 

Each of these reference types has an “Image” field that can hold an actual graphic, a figure, or a file path.  

The “Caption” field, below it, is used to store a short description of the image. 

 

Please refer to your EndNote manual for instructions on inserting graphics/images into your library and 

managing them in your document. 

  

Also, the on-screen Help contents in EndNote are well-written and easy to use. 

 
Linking to a file (and storing pdfs) within a library record 
 

To link an EndNote reference to a file, such as a stored pdf file: 
 

1. Select a reference in the library window or open a reference. 

2. From the References menu, choose Link To. 

3. In the dialog box that appears, select a file that you would like linked to the selected (i.e., open) 

reference,and click Open. 
 

The path of the file location will be displayed in the URL field of the reference record as an active link. 

 

To link a reference to a Web site, simply type the URL into EndNote's URL field. You do not need to use 

the Link command. Note that when you type a Web address into the URL field, EndNote underlines it and 

changes the color of the URL to indicate that it will function as a clickable link to the web site. Clicking 

the link works just like choosing the Open Link command. 

 

Endnote X allows storage of the actual pdf article file in a field of the corresponding record. 

 
Downloading Citations from Databases 
 

After completing the lengthy process of manually entering information into an EndNote library, most 

software users will be eager to learn how to automatically download citations from databases into their 

EndNote libraries. 
 

The EndNote manual contains instructions for downloading records from many different sources. 

The following pages of this workbook provide instructions for downloading from: 

 Ovid databases (e.g.,  MEDLINE) ................................................................ Page 11 

 PubMed MEDLINE ......................................................................... Pages 13 and 14 

 Science Citation Index Expanded.................................................................. Page 15 

 

 Library Catalog of the Library of Congress (for book records)  .................. Page 16 
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Downloading Citations from Databases, cont’d. 
Exporting Records from Ovid databases 
  

1. Complete a search in any Ovid database (such as MEDLINE) or locate one 

particular reference using the “Find Citation” link.in the green Search box.. 

 

2. Choose DISPLAY to see results, then click the check boxes beside the citations you 

wish to select. 

 

3. Scroll up or down to the Results Manager and make the following selections:: 

 

 Results  ◉ Selected Results (or “All in this set (1-1)” if 

                                      one particular citation is located) 

 Fields   ◉ Complete Reference 

 

 Result Format ◉ Direct Export 

 

 Actions  ◉ SAVE 

 

 

4. At the next screen, choose the second radio button (“Export results to Endnote, 

Procite, or Reference Manager”) and Click CONTINUE. 

 

5. EndNote will open, and the Select a Reference Library: window will appear. 

Click the library (.enl file) where you want the references to go. 

 

Click Open. The newly imported citations will appear in the library window. 

 

6. EndNote displays just the new citations you imported.  To view all of your 

references, click  References  Show All References. 
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Downloading Citations from Databases, cont’d 
PubMed has no direct export feature as in Ovid and other databases! 

Use one of these two methods to retrieve citations from PubMed: 
Method A. Connect to PubMed through EndNote and use EndNote’s search interface to search and 

transfer references into your EndNote library.  

Method B. Perform a search using PubMed‟s search interface, save the records as a text file, and then 

import the saved records into your EndNote library. 

Downloading Records from PubMed, Method A  
 

1. Open your library. 

 

2. Tools  Connect  Connect…. 

The Choose a Connection File window will appear. 

[In EndNote X1 and newer, the commands are:   

Tools  Online Search  New Search] 
 

3. Scroll down and select PubMed (NLM). 

 

4. Click the Connect button. 

The Search PubMed MEDLINE at PubMed (NLM) window will appear. 

 

5. To search any PubMed field (including author, title, journal, etc.): 

Enter your search term in the search box under Any Field.  

  

6. To search a particular PubMed field (e.g., author): 

Click the ▼ next to Any Field and select the desired field. 

Enter your search term in the search box. (Enter author names as smith, ab). 

 

7. To combine search terms (e.g., author and title): 

Click the ◉ for And, Or, or Not. 

Select the desired field and enter a search term. 

Click the Add Fields button at the bottom of the window to add more search boxes. 

 

8. Click the Search button. 

The Confirm Remote Search window will appear with the number of references. 

Click OK to retrieve the references. 

The Connected to: PubMed MEDLINE at PubMed (NLM) window will appear. 

 

9. To insert a reference into your EndNote library: 

Select the desired reference  Copy # Reference(s) To  filename(.enl). 

The reference will be inserted into your library. 

Tips 

To view the full reference including the abstract, double click on it. 

To select more than one reference, hold down the Ctrl key while clicking on the 

desired references. 

To search again, minimize the filename.enl and Connected to: windows. 
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Downloading Citations from Databases, cont’d. 
 

Downloading Records from PubMed, Method B   
 

1. Complete a search using PubMed MEDLINE. 
 

2. Click the check boxes beside the citations you wish to select. (You can also collect 

checked citations and “send to” the clipboard if you like.  Then click on the 

Clipboard Tab and continue with step 3.) 
 

3. At the top (or bottom) of the page, where you see the Display button, click the ▼ 

and select MEDLINE. 
 

4. In the same gray bar, where you see the Send to button, click the ▼ and select File. 

Click the Send to button.   (You may need to click on the yellow bar that appears 

near the top to allow the download.)  When the  File Download window appears, 

choose Save. 
 

5. In the Save As … window:  

   a.  Select a location to save the text file of records. 

   b. Give the file name as follows: filename.txt 

   c.  The “Save as type” window should say Text Document (or choose 

        All Files.) 

   d.  Click the Save button. 

   e.  Remember the name and location of the .txt file. 

 

Importing the PubMed Records into EndNote through a filter  
  

With your library open, click….  
 

1. Edit  Import Filters  Open Filter Manager … 
 

2. The EndNote Import Filters window will appear.  

Scroll down and click the check box for PubMed (NLM). 

 

3. Close the EndNote Import Filters window. 

 

4. File  Import…  
The Import window will appear. 

 

5. In the box next to Import Option:, it should say PubMed (NLM).   
 

6. Click the Choose File… button. 

The Open window will appear. 
 

7. Open the location where you saved the .txt file.  Make sure the file type is set to  

All Files (*.*)      Select the .txt file and click the Open button. 

The name of the file will appear in the Import window. 
 

8. Click the Import button to import the citations.   To view all your references, click 

References  Show All References. 
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Downloading Citations from Databases, cont’d. 
 

Exporting Records from ISIôs Web of Science, Science Citation Index 
Expanded 
  

1. Complete a search using ISI Web of Science (Science Citation Index Expanded). 

 

2. Click the check boxes beside the citations you wish to select. 

 

3. Click the Add to Marked List button at the top of the results list . 

 

4. Click Marked List at the top of the screen. 

 

5. Under Step 1 [see image below], select  fields you‟d like to include in addition to 

the author(s), article title, and source.  

 

6. Under Step 2, click the  button. 

 

On the next page, choose Export. 

 

7. EndNote will open and the Select a Reference Library: window will appear. 

Click the library (.enl file) where you want the citations to go.  Click Open 

 

8. The newly imported citations will appear in the library window. 

 

9. EndNote displays just the new citations you imported.  To view all of your 

references, click  References  Show All References. 
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Downloading Citations from Databases, cont’d 
 

Library Catalog of the Library of Congress :  Downloading book records 

 

Connect to the Library of Congress through EndNote and use EndNote‟s search interface to locate and 

transfer book records into your EndNote library.  

 

1.  Open EndNote and open the appropriate library. 

 

2.  Tools  Connect  Connect…. 

     The Choose a Connection File window will appear. 

                   [In EndNote X1 and newer, the commands are:   

                    Tools  Online Search  New Search] 
3. Scroll down and select Library of Congress. 

 

4. Click the Connect button. 

The Search “Library Catalog at Library of Congress” window will appear. 

 

5. To search any field (including author, title, keyword, etc.): 

enter your search term in the search box under Any Field.  

  

6. To search a particular field (e.g., author, year, ISBN): 

click the ▼ next to Any Field and select the desired field. 

Enter your search term in the search box.  

 

7. To combine search terms (e.g., author and title): 

Click the ◉ for And, Or, or Not. 

Select the desired field and enter a search term. 

(Click the Add Fields button at the bottom of the window to add more search 

boxes.) 

 

8. Click the Search button. 

The Confirm Remote Search window will appear with the number of references 

found. Click OK to retrieve the references. 

The Connected to: Library Catalog at Library of Congress window will appear 

and the references located will load into a window that looks like a “temporary 

library.”. 

 

9. To insert a reference (or references) from this window into your EndNote library: 

Select the desired reference(s) then click the gray button and 

 Copy # Reference(s) To  filename(.enl). 

The book reference(s) will be inserted into your library. 

 

You can also try searching the WorldCat catalog for book records. 

As in Step 2 above, in the Choose a Connection File window, scroll down to 

and choose WorldCat (OCLC). 
 If prompted for a “remote password,” make sure both boxes are blank and click OK. 
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Inserting Citations and Generating a Bibliography 
 

A citation is the bibliographic information in the body of a paper that refers the reader to a reference in 

the bibliography. Selecting a bibliographic style determines how EndNote formats citations. EndNote 

has more than 3600 bibliographic styles. Styles can also be modified to create new styles. 
 

Selecting a Bibliographic Style 
 

1. With your library open in EndNote,  

from the top menu, click Edit  Output Styles  Open Style Manager … 

The EndNote Styles window will appear. 

 

2. Browse the list of styles and click the check box for the desired style. 

Additional styles can be downloaded from the EndNote web site: 

http://www.endnote.com/support/enstyles.asp 
 

3. Important Note 

Your library may contain citations with the full journal name (e.g., Journal of Cell 

Biology if you used Ovid) or the abbreviated journal name (e.g., J Cell Biol if you 

used PubMed). By default, when EndNote creates a bibliography, it will keep the 

journal name in the same format that it was imported. If you imported a Journals 

Term List – See page 6  (e.g. Medical) you can choose to have the journals 

names appear as full or abbreviated.  Carefully check the journal style and edit as 

below. 

 

a. In the EndNote Styles window, highlight in blue the desired style 

b. Click the Edit button. The Journal style editor window will appear. 

c. From the list of options on the left  Journal Names. 

d. To use the abbreviated name: Click the ◉ to the left of Abbreviation 1 (with 

periods)  or Abbreviation 2 (without periods) 

e. To use the full name: Click the ◉ to the left of Use full journal name. 

 

Note: Other elements of the style (e.g., page numbers) can be modified by clicking 

on choices in the left frame of the style editor.  Particularly note the templates 

section under Bibliography.  The elements of the “Journal Article” template can be 

modified using Word editing tools, e.g., bold, italic, cut and paste, etc. 

See next page for a picture of the style editing window. 
 

f. Close the Journal style editor window. 

g. The Save changesé? window will appear. Click Yes. 

 

4. Close the EndNote Styles window. 

 

5. Edit  Output Styles  click the desired style.  Leave the library open.  

(Click on any record in the library and notice that you will see below a preview of 

how the reference will look in the chosen style.  If this is not showing, click “Show 

Preview” at the bottom of the library.) 
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STYLE EDITING WINDOW: 

  
=================================================================== 

 

Inserting Citations and Generating a Bibliography, cont’d. 
Inserting Citations into a Paper 
  

1. Open your paper in Microsoft Word. 

 

2. Position the cursor at the point in the text that you want the citation to be inserted. 

Put in a space. 

 

3. From the Tools menu in Microsoft Word  EndNote  Go to EndNote. 

Your library (filename.enl) will appear. 

 

4. Click the desired reference. 

To select more than one reference, hold down the Ctrl key while clicking on the 

desired references. 

 

5. Tools Cite While You Write  Insert Selected Citation(s). 
The citations will be inserted into your paper and a bibliography generated at the 

end of your paper.  

 

Alternate Method of Inserting Citations into a Paper 
  

1. From the Tools menu in Microsoft Word  EndNote  Find Citation(s)… 

The EndNote Find Citations window will appear. 

 

2. In the Find:  box, enter identifying text to locate the desired reference (e.g., 

author‟s last name and/or keyword). 

 

3. Click the Search button. 

EndNote will list matching references. 

 

4. Click the desired reference  click the Insert button at the bottom of the screen. 

The citation will be inserted into your paper.  
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Inserting Citations and Generating a Bibliography, cont’d. 
 

Printing Library Records and Creating an Independent Bibliography 

You can create a separate bibliography page without inserting citations into a paper. 

In your open library: 

 

1. Select a bibliographic style. 

See page 16 for instructions. 

 

2. To include all references in the bibliography, Edit  Select All. 

To include specific references in the bibliography, hold down the Ctrl key while 

clicking on the desired references. 

 

3. Edit  Copy Formatted. 

 

4. Open a document in Microsoft Word. 

 

5. From the Edit menu in Microsoft Word  Paste. 

 

 

 
 

 

__________________________________ 

Enabling Instant Formatting 

If a formatted bibliography is not generated after you insert a citation, you will need to enable EndNote‟s 

Instant Formatting. 

  

1. From the Tools menu in Microsoft Word  EndNote  Format Bibliography… 

The EndNote Format Bibliography window will appear. 

 

2. Click the Instant Formatting tab  Enable  OK. 
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Editing Citations in Your Paper 

Changing the Bibliographic Style 

  

1. Open EndNote. and open your EndNote library (.enl file). 

 

2. Edit  Output Styles  Open Style Manager … 
The EndNote Styles window will appear. 

 

3. Browse the list of styles and click the check box for a new style. 

 

4. Close the EndNote Styles window. 

 

5. From the Tools menu in Microsoft Word  EndNote  Format Bibliography… 

The EndNote Format Bibliography window will appear. 

 

6. In the box next to With output style:, click the ▼ and select the desired style. 

 

7. Click OK. 

The bibliography will be reformatted in the chosen style. 

 
The Layout tab (above right) in the Format Bibliography window offers more choices to adjust the look 

of the bibliography, such as line indentation and spacing and font size and style. 
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Editing Citations in Your Paper, cont’d. 
 

Editing Individual Citations ï Make your changes  in the library record, not in Word! 

 

1. Open EndNote. and Open your EndNote library (.enl file). 

 

2. Double-click on the record you wish to change. 

 

3. Make the appropriate changes. 

For example, in the Journal  field,  change “Anesthesia & Analgesia” to 

“Anesthesia and Analgesia”, so that when the bibliography is formatted, the journal 

name will appear in its abbreviated form.  

See page 6 for how to import a journal list with journal name abbreviations. 

 

4. Close the Author, Year, record # window in EndNote to save changes. 

Leave your EndNote library open. 

 

3. From the Tools menu in Microsoft Word  EndNote   Format Bibliography… 

The EndNote Format Bibliography window will appear. 

 

4. In the box next to With output style:, click the ▼ and select the desired style. 

 

5. Click OK.  [The bibliography should now reflect changes you made to the record.] 

 
 

Adding New Citations 

  

1. Open EndNote. 

Open your EndNote library (.enl file). 

 

2. Open your paper in Microsoft Word. 

 

3. Position the cursor at the point in the text where you want the new citation to be 

inserted.  Put in a space. 

 

4. To add a new reference to an existing citation, position the cursor next to (not 

within) the existing citation in the body of paper. 

 

5. Insert new citation(s).. 

 

6. Click OK. 
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Editing Citations in Your Paper, cont’d. 
 

Deleting Citations 

 

Do not delete citations in your paper using Word commands or with the delete key. The 

citation, bibliography entry, and associated codes may not be completely deleted and 

you could corrupt your document. 

 

1. With both your EndNote library and Word document open, click on the citation(s) 

to delete in the body of your paper in Microsoft Word. [Citation(s) will be grayed.] 

 

2. From the Tools menu in Microsoft Word  EndNote  Edit Citation(s)… 

The EndNote Edit Citation window will appear. 

 

3. Make sure the citation to delete is highlighted. 

 

4. Click Remove  OK. 

 

 
 

Moving Citations  

1. Open EndNote and your EndNote library (.enl file). 

 

2. Open your paper in Microsoft Word. 

Make the appropriate changes to your paper by using Cut, Copy, and Paste 

commands in Word. 

 

3. The citations will be reformatted and the order corrected in the bibliography. 
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More about EndNote 
 

Help is available from the librarians at the Lamar Soutter Library 

 

 Judy Nordberg ........... Judy.Nordberg@umassmed.edu ....... 508-856-2921 

 Sally Gore ................. Sally.Gore@umassmed.edu .............. 508-856-1966 

 Nancy Harger………. Nancy.Harger@umassmed.edu..........508-856-3334 

 Len Levin……........... Len.Levin@umassmed.edu ………...508-856-6028 

 

      LIBRARY SERVICE POINT ............................................ 508-856-6099 

 

 

 

 

Contacting EndNote  (Thomson Scientific - ISI Researchsoft) 
 

 Tech support telephone:    800-336-4474 (9 AM - 8 PM Eastern , Monday – Friday) 

At the prompt press 4, and then select "ResearchSoft Products" option. 

 

 EndNote tech support website:  

http://www.endnote.com/support/entechform.asp 

Also, View the List archives (hosted by Adept Scientific and maintained by ISI 

ResearchSoft)        http://lists.adeptscience.co.uk/endnote/  

 

 Internet:                 http://www.endnote.com   
               Access Support and Services, FAQs, contact information, email inquiry 

               form, and other troubleshooting help pages. 

 

 

 

EndNote Software can be ordered from the UMass Medical School Book Store 

 

 Student Price  ....................................  ~$121.00 (plus tax) 

 

 Price for non-students .......................  ~$242.00 (plus tax) 

 

 

Endnote Software can also be purchased online from a variety of software 
distributors:    e.g., Amazon, PriceGrabber and Academic Superstore 
http://www.academicsuperstore.com/ 
  

 
 

         Updated June, 2009    ©2009
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